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Introducing NJ-GeoWeb – The Successor to i-MapNJ 
 

The Bureau of Geographic Information Systems (BGIS) is building NJ-GeoWeb, a suite 
of data and feature-rich web-based interactive mapping applications. The applications 
are being built using Orion™ OnPoint™ software which will enable BGIS to more rapidly 
develop applications with better performance, greater functionality, security (when 
necessary), and greater ability to more easily integrate with new and existing 
applications, reports, and documents.  NJ-GeoWeb will use new and existing map 
serving technologies and will be able to connect to data from many different sources 
(NJEMS, COMPASS, potentially non-DEP, etc.), as well as link to online reports (DEP 
Data Miner) and other documents.  NJ-GeoWeb will allow the combining of map layers 
from multiple map services into a single integrated map.  NJ-GeoWeb applications will 
run for a period of time side-by-side with the existing i-MapNJ applications. However, the 
plan is to eventually replace i-MapNJ applications with similar applications in NJ-
GeoWeb. 
 
As mentioned, one of the major improvements over the i-MapNJ applications will be 
better performance.  The NJ-GeoWeb applications will be running on a dedicated 
production server at New Jersey Office of Information Technology (NJOIT) and will not 
be sharing resources with other applications.  There is also a fail-over server that should 
help in the event that the primary production server requires support.  
 
All of the major tool functions that exist in the Internet i-MapNJ DEP application are 
present in NJ-GeoWeb.   NJ-GeoWeb has expanded functionality for selecting features, 
measuring, and buffering.  These tools are grouped under Advanced Tools.  A new 
Generate URL tool enables a user to capture a URL string that when executed will 
launch the NJ-GeoWeb application zoomed to the same map extent.  Also, selected 
features can be saved and later retrieved by the user or shared via e-mail.   
 
Multiple profiles of NJ-GeoWeb can be developed (currently there are three) and each 
profile can have its own set of multiple Map Tabs.  The developers of NJ-GeoWeb 
applications can designate what GIS layers are to be included for each map tab.  The 
user can easily switch between map tabs by clicking on a different tab.  The spatial 
extent of the map is maintained, but the GIS layers available to the user change. 
 
The first profile/map tab is called GeoWeb and has been developed to suite the needs of 
a general audience that may be interested in viewing what environmental information 
exists in the vicinity of a location or area of interest. The GeoWeb profile allows users to 
view and interact with a very diverse set of environmental map layers and related data. 
Users may run searches to find a location or area of interest, display features from the 
mapped data layers, and view environmental data associated with those features. Tools 
are provided to allow users to select and buffer features, measure distances and 
calculate areas, and determine or locate and display NJ state plane coordinates. 
 
The Well Drillers profile/map tab has been developed as a customized version of NJ-
GeoWeb for the New Jersey well drilling community. The Well Drillers profile provides 
the mapped layers and tools to allow well drillers to find a location or area of interest, 
determine if the location is in or near the New Jersey Highlands or Pinelands areas, view 
possible groundwater contamination concerns in the area, measure distances between 
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locations and determine the New Jersey state plane coordinates for Well Permit 
Applications.  The GeoWeb map tab is also included in this profile. 
 
The Volunteer Water Monitoring profile/map tab has been developed as a customized 
version of NJ-GeoWeb for users participating in the volunteer monitoring program 
coordinated by NJDEP's Water Monitoring & Standards' Bureau of Freshwater & 
Biological Monitoring. This profile allows for the public, volunteer monitoring community, 
local, state and federal agencies to review and share information and data. This profile 
provides the mapped layers and tools to allow users to locate monitoring stations within 
an area of interest, view monitoring station information, and view collected monitoring 
data in linked custom DEP Data Miner reports. There will be additional layers added to 
this profile in the near future, including site locations of pipes and ditches.  The GeoWeb 
map tab is also included in this profile. 
 
The Queries in i-MapNJ are called Searches in NJ-GeoWeb.  Searches are by default 
independent of the map tabs in NJ-GeoWeb.  Any search developed in NJ-GeoWeb is 
available for use in any map tab, so long as security has not been set to restrict its use.   
 
In an effort to provide more environmental data related to features from specific map 
layers, BGIS has established document links that leverage existing DEP Data Miner 
reports.  DEP Data Miner is an independent NJDEP web-based reporting application.  
These links enable access to additional information associated with selected features 
from the NJEMS Sites and Volunteer Water Monitoring Stations layers. 
 
The purpose of this document is to enable users to become familiar with NJ-GeoWeb.  
No doubt users accustomed to using i-MapNJ will find it different in a number of ways.  
Keep in mind that while BGIS has done some customization work on the application, it is 
still very close to its original user interface.  BGIS plans to make further customizations to 
improve the user experience and add functionality to make NJ-GeoWeb a very powerful 
and useful tool for NJDEP staff and the public.  

1.  NJ-GeoWeb Interface 
Users of i-MapNJ will notice a new look with numerous user interface differences. The 
interface presented to the user consists of a Map View Frame, a Map Tools toolbar, the 
Layer Manager, and Advanced Tools buttons.  By default the Layer Manager is open 
and the Advance Tools is closed when the application is launched. Many of the tools 
launch windows that can be moved and placed anywhere on the application window.  
When finished with using a tool the user can close its window. 



Map 
View 

Frame 

Map, Search, and Results Tabs

Open Advanced Open Layer 

North Arrow

Map 
Tools 

Scale Bar 

Set Custom Scale 

Use Layer Manager to 
Turn Layers on and off.  
Right-click to make layer 

Active, Zoom to layer, 
Zoom to scale, or View 

layer Metadata 

Change Size 
of Map View 

Frame

Profiles

Data Layer Information 
and Metadata

Figure 1. NJ-GeoWeb Functionality 
 
Also notice that near the top-left of the screen there are tabs for Map and Search.  At 
start-up the Map tab is selected, but the Search tab is activated with a mouse click on 
the tab.  This tutorial begins by discussing the Map tab functions.   
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Map View Frame 
The Map View Frame shows the main map 
display, and is the major focus of the 
application. This is the area where map 
layers are displayed at different zoom levels 
(or scales) and where the user can pan and 
zoom to areas of interest.  By default, the 
opening of the application displays New 
Jersey and county boundaries along with the 
Mid-Atlantic States layer. The Map View 
frame also displays the North Arrow and 
Scale Bar and has text on the borders for 
compass directions (north, south, east and west) that pan the map when clicked. 

 
Figure 2. Map View Frame 

 

Map Tools Toolbar 
The toolbar provides most of the basic functions of the application.  Tools can be used to 
find an area of interest in the Map View by zooming in or out to different scales, and by 
panning around the map by clicking and dragging the map.  The Identify  tool provides 
information from the active layer when the features are clicked on. The Previous Map  



and Next Map  tools are helpful to return to geographic locations or extents, and the 
Full View  tool returns the map to the extent of New Jersey. The Legend  tool opens 
a window that provides the legend (or key) to the symbolization of the layers on the map.  
The Generate URL  page creates a web link back to the application that can be saved 
or e-mailed.  Finally, the Help  tool opens a NJ-GeoWeb help topics window.  A 
summary of each tool is provided in Figure 3.  
 
NOTE: The function of all the tools on the tool bars in NJ-GeoWeb can be revealed by 
holding the mouse cursor over the tool’s icon. When in doubt as to the name or function 
of a tool, use this feature. 
 

 

Layer Manager 
 
Layer Manager enables the turning on and off of mapped layers, and is a floating control 
that can be moved to any location on the display, minimized, or closed. Layers are 
organized into groups that can be expanded to show what layers they contain (click on 
the plus symbol  next to the group). Layers are grouped in commonly recognized 
categories, as shown in Figure 4. 

 Zoom In Zoom In by either clicking on the map or dragging a rectangle on the map 

 Zoom Out Zoom Out by either clicking on the map or dragging a rectangle on the map 

 Pan Pan the map by clicking and dragging the map to a new location 

 Identify Provides attribute data of a feature from the currently active layer 

 
Previous 

Map Changes the map back to its previous extent 

 Next Map Changes the map forward to its prior extent 

 Full View Zoom to full view (initial extent) 

 Legend Opens the legend which displays the symbols of currently visible layers 

 
Generate 

URL 
Opens the Generate URL window, providing the ability to create a URL 
(which can be copied) that will launch the same application, zoomed to the 
current extent, with an optional label 

 

Figure 3. Summary of Map Tools 
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Figure 4. Layer Manager Features 

 
Layers are turned on by clicking the checkbox next to the layer name and then clicking 
the Apply button. Another click in the checkbox will turn a layer off when the apply 
button is clicked. Layer names that appear grayed-out are not visible at the current map 
scale.  Placing the mouse cursor over a grayed-out layer name and holding it still for a 
few seconds will activate a mouse-over popup that indicates the scale range at which the 
layer can be viewed.   
 
The layer order can be changed by holding down the left mouse button on a layer name, 
and dragging it to a new location.  Layers higher in the stack will draw on top of those 
that are below. 
 
Right clicking on a layer name launches a layer menu through which a user can make 
the layer “active”, zoom to the layer’s extent, zoom to the scale at which the layer 
becomes visible, or view the layer’s metadata. 
 

Advanced Tools 
Advanced tools include some features GIS users expect, but also some new capabilities.  
This is a floating toolbar (see Figure 5.) and it can be moved or closed.  When one of the 
tools is clicked, a new window will be opened for that particular tool.  
 
 

 5

 
Figure 5. Advanced Tools Control 

 
 
 
 
 
 
 
 



The available tools are Selection, Measure, Buffer Selections, and Locate Point 
Using NJ State Plane Coordinates. The tool bars for each of these are shown and 
described in Figure 6 below. 

 

 

Selection Tool 
Used to select features from the currently active layer.  
When features are selected, they are highlighted on 
the map and are listed in the selection list.  The 
selection list tracks both selections that are current 
and those that had been completed during a previous 
selection process or search.  Selections can be saved 
and previously saved selections can be retrieved.  

 

 

Measure Tool  
Used to measure a distance, an area or a point 
location in NJ State Plane coordinates.  Distance can 
be measured by either clicking on Measure Distance 
to find the length of one line, or by clicking on Multi 
Segment, which allows the user to determine the 
distance along a line made up of multiple points.  
Measure Polygon provides both perimeter and area.  
Measurements can also be added to the map display 
(Add to map) as a graphics and be added to the 
selection list or saved and retrieved at a later time. 

 

 

Buffer Selections Tool 
Used to create a buffer around a previously made 
selection.  The buffer menu allows the user to decide 
whether to buffer features from the active selection list 
or a point on a map, and the radius of the buffer.  The 
resulting selections from the buffer operation are 
denoted with asterisks in the selection list. 

 

 

Locate Point Using NJ State Plane Coordinate 
Tool  
Allows for the user to input x and y coordinates in 
order to find a specific point.  The coordinates are 
based on the NJ State Plane coordinate system and 
are measured in feet.  This function is most useful if 
the coordinates of the point are already known and 
the user wants to search for the location.  

Figure 6. Advanced Tools Descriptions 

 6



2.  Searches 
 
In addition to the Map tab there is also a Search tab which when clicked on replaces the 
map view window with the Search window.  When the Search window is open, individual 
tabs for the most frequently used searches in NJ-GeoWeb are displayed just under the 
Map and Search tabs. These tabs are the launching points for searches that have been 
created to get the user to an area of interest or to select and highlight features from a 
GIS layer.  To view and access the entire list of searches, click on the “All Searches” tab 
(last tab on the right). Currently, the following searches are available in NJ-GeoWeb: 
Address, County, Municipality, Place, Zip Code, Watershed Management Area, 
Watershed/Sub-Watershed, NJEMS Site (Figure 7b), and NJEMS Sites in Area of 
Interest. Additional searches will be added in the future as NJ-GeoWeb develops 
further. 
 
 

 

 
Figure 7a. NJ GeoWeb Search Feature Figure 7b. NJEMS Sites Search Example 

 
 

3.  Linking to DEP Data Miner 
 
Features from the NJEMS Sites GIS layer are linked to DEP Data Miner via their 
NJEMS Site ID.  This allows easy access to DEP activity, permitting, and enforcement 
data from a limited number (for now) of existing DEP Data Miner reports.  To access 
these reports, click on the document link at the bottom of the More Information window.  
The More Information window is opened when the user uses the Identify Tool on a 
feature from the NJEMS Sites layer.  The More Information window also opens when the 
user clicks on the label index (blue underlined numbers) for a feature in the Selection List 
window produced as a result of a search.  As shown in Figure 8, the search yielded a 
number of sites that matched the search criteria. Clicking the hyperlinked number next to 
the selections in the Selection List window opens the More Information window that 
displays attribute data for the corresponding feature.    
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Figure 8. More Information about Selected Sites 

 
Additional data is accessible by clicking the Documents link (Figure 9), which exposes 
the link to access Data Miner reports.  
  

 
 

Figure 9. Data Miner Link in More Information window 
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A great deal of information is available through the link to DEP Data Miner, including 
permit, inspection, violation and enforcement activities, searchable by date ranges 
(Figure 10).  
  

 
 

Figure 10. Data Miner Window 
 

4.  More Selection Tools 
 
Additional tools are available once a selection has been made and a selection list is 
displayed. When the Show More Selection Tools button  is clicked, a new window 
appears with these extra Selection Tools (see Figure 11). 
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Figure 11. Click for More Selection Tools
   
The buttons on this window enable additional functions related to the current selection 
list such as turning off and on the selection list, deleting the entire list, turning on or off 
the index numbers that identify listed items on the map, etc. This is also where a current 
selection list can be saved, or e-mail to another user. The buttons and their related 
functions are detailed in Figure 12.  
 

Toggles off/on the active selection in the Selection List Window. 

 Deletes the currently selected features from the Selection List. 

 
Toggles off/on the index numbers on the map that identify 
selected items from the Selection List. 
Opens a new window where selections can be named and 
saved, and be made private or made public for others to view. 
Once a selection is saved it can be e-mailed to others. 

 Zooms the map display to show all the selections from the list. 

 
Zooms the map to display only the selections that are active 
(checked in the Selection List window). 

 
Clears buffer rings if they are displayed on the map (that were 
created using the buffer tool on the Advanced Tools window) 

Figure 12. Selection Tools Window 
 
The ability to save a selection set can be very useful for keeping track of successful 
searches, or for sharing information with others via e-mail.  Give this feature a try after a 
successful search returns a list that you want to keep for future access.  Saved 
selections will be available for 30 days before being cleaned off the server.  If you want 
to save a selection list for a longer time, consider e-mailing it to yourself. 
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5.  Printing the Map 
 
NJ-GeoWeb does not currently have a built-in Print feature. At this time, the print 
capabilities are not up-to-date with the current software running the application.  Please be 
patient and check back for the print options when the next version of NJ-GeoWeb is 
launched.  An easy way to print your map is to use the browser’s own print feature.  This is 
usually accessed via the browser’s file menu or via a printer icon .  It is also possible to 
print your map with the work-around outlined below: 
 
 

1) Make sure your ‘View Frame’ and other needed features (e.g., ‘Selection List,’ 
‘coordinate display, etc.) are completely visible (remove other tool windows if 
necessary). 

2)  On your keyboard hold down <Alt> and press <PrintScrn>.  This will create an 
image of the active window on your computer screen and send it to the clipboard. 
Using the <PrintScrn> key alone will save an image of what is currently visible on 
your screen, and can be used to capture multiple windows.  

 

 
Figure 13. Print Screen Key and Alt Key Locations 

3) On the bottom-left-hand corner of your computer screen, click the Start button.  Go 
to All Programs Accessories  Paint. 

4) In Paint go to Edit > Paste.  The image of your computer screen should paste in 
the Paint dialog.  
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Figure 14. Pasting Image into Paint 

5) Go to File > Page Setup, for ‘Orientation’ select Landscape, uncheck Horizontal 
and Vertical Centering, and change Scaling to 65% of Normal Size. Click OK. 

6) Go to File > Print Preview and make sure your image fits on the paper before 
printing. 

7) When satisfied with your image, click Print. 
 
Using this technique, or your favorite screen capture or graphics software, it is possible 
to create printable map and report output.  Also, images, text and data can be pasted 
into word processing or spreadsheet applications in order to produce graphics and tables 
for maps or reports.  
 
 
 

6.  Tutorials 
 
The following series of scripts walk users through most of the significant functionality that 
exists in NJ-GeoWeb.  There are some additional tools and functionality that have not 
been included in this initial version of NJ-GeoWeb.  Feel free to deviate from these 
scripts to explore on your own.  It is usually best to quit out of NJ-GeoWeb before 
starting each new script. 

NJ-GeoWeb Tutorial 1:  Environmental Investigation 
 

1. Launch NJ-GeoWeb  
 
2. Click on the Search tab.  Use the Address Search to search for an address you 

know exists in NJ.  Enter Street and ZIP Code. Click on Search button.  If found, 
the map will plot a symbol at that address, and place the address record in the 
Selections List window.  Ex:  401 e state st   08608 

 
3. Type 10000 in the Scale textbox (lower left corner of map view frame), then click 

on the arrow  button to its right. 
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4. Click on Advanced Tools to open the advanced tools toolset and click on Buffer 

Selections . 
 

5. In the first dropdown, select the Buffer a point on map option, select Known 
Contaminated Sites List as the Target Layer, and enter 1 mile as the buffer 
radius. Click the Point on Map button, and then click on the map at the center of 
the symbol that marks the found address.  The application will find any Known 
Contaminated Sites within a 1-mile range from the location clicked on the map.  
These Known Contaminated Sites will be highlighted and the first 20 will be 
labeled.  A Known Contaminated Sites List selection list will be added to the 
Selection List dialog and the reference numbers will correspond to the labels on 
the map. 

 
6. To see all of the Known Contaminated Sites found within the 1-mile buffer on the 

map, click on the Show more selection tools  button at the upper right corner 
of the Selection List window to open the Selection Tools menu and then click 
on the Zoom to All Selections  tool.  

 
7. Use the Zoom In  tool to zoom in on one of the labeled Known Contaminated 

Sites.   
 

8. Find the corresponding label number in the Selection List window and click on 
the label number hyperlink to get more information on the site and view the 
additional attribute data.   

 
9. At the top of the More Information window, in the Select Reports dropdown, 

select Basic Report (HTML) and click View.  The contents of this new window can 
be printed by selecting File > Print or the text can be selected, copied and pasted 
into another document. Close the new window and the More Information 
window. 

 
10.  Next clear all of the selected features by clicking on the Delete Selection List  

button at the top of the Selections List window, and close the Selection Tools 
menu.  

 
11.  Close the Buffer Selections window and the Advanced Tools window. 

 
12.  Click on the Search tab.  Select the Watershed/Sub-Watershed search to 

search for a sub-watershed (HUC14).  The sub-watershed dropdown list initially is 
populated with all sub-watershed names in NJ.  By selecting from the preceding 
dropdowns (Watershed Management Area then Watershed) the Sub-Watershed 
dropdown list is reduced.   Select a Watershed Management Area, a 
Watershed, and then a Sub-Watershed then click the Search button.  The map 
will zoom to the sub-watershed and a sub-watershed record will be added to the 
Selections List window. Ex: Lower Raritan, South River, and Lawrence; 
Matchaponix Brook; Barclay Brook. 
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13.  Note that additional tools are available from the Selections List window, by 

using the buttons at the top right.  These tools are, 
from left to right, the Report Export/Editor, Set 
Selection List as Active, Delete Selection List, Apply Selections, 
Expand/Collapse window, and Show More Selection Tools.  

 
More tools are available when the Show More Selection Tools button  is 
clicked.  This will open another window titled Selection Tools that displays 
additional functions.  (These are described in Chapter 4, page 10.) 

  
 
Also helpful is the hyperlinked number next to each item of the 
selection list:   Clicking on this link will provide attribute 
information for that item. 

 
 

14.  In Layer Manager, expand the Environmental Monitoring layer group (click on 
the plus symbol ), and check on Ambient Biomonitoring Network (AMNET).  
Click on the Apply button at the top of the Layer Manager window.  

 
15. Click on the plus symbol  next to the Ambient Biomonitoring Network layer 

name to see the symbology scheme.  Click on the Environmental Monitoring 
layer group’s minus symbol  to contract the group’s list. 
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16. Look for any Ambient Biomonitoring Network points that are red or yellow circles 
(denotes severe or moderate biological impairment).  Use the Zoom In   tool 
(Map Tools toolbar) to zoom in to a smaller area surrounding one of these points.  
The resulting scale should be a map scale larger than 1:25,000 (i.e. 1:24,000).  If 
it is not, type the scale number in the scale text box in the lower left corner of the 
map view frame, and click on the  button.  

 
17. In Layer Manager, expand the Water layer group (click on ), and check on 

Streams and Water Bodies.   Expand the Sites and Facilities layer group and 
check on NJEMS Sites and Known Contaminated Site List.  Expand the Land 
layer group and click on Land Use 2002.  Click the Apply button at the top of the 
Layer Manager window.  Click on the Water, Sites and Facilities, and Land 
layer group’s minus symbol  to contract the groups’ lists. 

 
18. From the Map Tools toolbar, click on the Legend Tool  to open the legend 

window.  Notice which symbols represent which layers.  Close the Legend. 
 

19. Industrial pollution sources as well as land use activities are likely impacting the 
ambient biological communities here.  From the Map Tools toolbar, click on the 
Identify  tool, and then click on a Land Use polygon near the severely impaired 
Ambient Biomonitoring Network point.  In the More Info window click on the 
Attribute Details For dropdown and select Land Use 2002.  Click on several 
surrounding Land Use 2002 polygons.  Do the same for any NJEMS Sites or 
Known Contaminated Sites List features.  To see the information for these, 
change the Attribute Details For dropdown to those layers. 

 
20. After identifying a feature from the NJEMS Sites or Known Contaminated Sites 

List, scroll to the bottom of the More Information window and expand the 
Documents list by clicking on the .  Click on the document link to access Data 
Miner reports.  The resulting page will display NJDEP program interests for this 
site.  After viewing, close the Data Miner application window and the More 
Information window. 

 
21. Click on the Search tab and then the All Searches tab.  Click on the NJEMS Site 

search link.  Enter 46935 as the Preferred ID Number make sure Program 
Description is blank and click on the Search button.  The application zooms to the 
site, and the NJEMS site record is added to the Selection List window. 

 
22. Click on Advanced Tools to open the advanced tools toolset and click on Buffer 

Selections . 
 

23. In the first dropdown in the Buffer Selections window, select the Buffer active 
selections option, select Streams as the Target Layer, and enter 2000 feet as 
the buffer radius. Check the Show buffer shape only checkbox (when this 
executes, no selections will be made from the Streams layer, only the outline of 
the buffer will be drawn).  Click the Select button and the buffer will draw.  
Remove the buffer outline by clicking on the Show more selection tools  
button on the Selection List window menu to open the selection tools toolbar 
and click on the Clear Buffer Rings  tool. In the Buffer Selections window 
uncheck the Show buffer shape only checkbox and run the buffer again by 
clicking the Select button to generate the buffer.  The application will find Streams 
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within 2000 feet of the NJEMS Site.  The Streams will be highlighted and labeled.  
A Streams selection list will be added- to the Selection List window and the 
reference numbers (hyperlinks) will correspond to the labels on the map.  On the 
Selection Tools menu click on the Zoom to All Selections  tool to see the full 
extent of the selected streams. 

 
24. Close out of NJ-GeoWeb. 

 16



 

NJ-GeoWeb Tutorial 2: Searches and Selections 
 

1. Launch NJ-GeoWeb  
 
2. Click on the Search tab.  Use the Place search to search for a place in New 

Jersey by first selecting a county (Somerset) and then the Place (Kingston) from 
the dropdowns and click the Search button.  The map will zoom to the selected 
place location and add that place name in the Selections List window. 

 
3. In Layer Manager, expand the Sites and Facilities layer group by clicking on 

next to it, and check on Known Contaminated Sites List.  Click the Apply 
button at the top of the Layer Manager window.  Click on the  for the Sites and 
Facilities layer group to contract the group’s list. 

 
4. Click on Advanced Tools to open the Advanced Tools toolset.  Click on the 

Measure  tool. 
 

5. In the Measure window, click on the View Coordinate  tool, and click on the 
label that represents the place name location on the map.  The NJ State Plane 
coordinate value for the location clicked will appear in the Measure window.  Click 
on the Measure Circle  tool.  Use this to determine the closest Known 
Contaminated Sites List facility to the place name point.  First, click on the place 
name point, and then move the mouse away from the point.  A circle will expand 
as you move the mouse.  Expand the circle until the closest Known 
Contaminated Sites List facility is reached. Mouse click again to set the circle.  
In the Measure window, the distance to the facility (radius of the circle) will be 
indicated.  The user may change the distance units (feet or miles) by using the 
Distance Unit dropdown. 

 
6. In the Measure window, click on the Clear  button (which is located right above 

the Add to map button) to clear the circle.  Close the Measure window and close 
the Advanced Tools window. 

 
7. Delete the Place Names Selection List by clicking on the Delete Selection List 

 button in the Selection List window. 
 

8. Click on the Full View  tool on the Map Tools toolbar. 
 

9. Click on the Search tab, and then click on the County tab to run a county search.  
Select several counties from the dropdown menu by either holding down the Shift 
key and/or the Ctrl key, and click on the Search button. The selected counties will 
be highlighted in pink on the map, and a Selections List window will open and list 
the counties selected along with some attribute data.  The labels on the map 
correspond to the blue hyperlink index numbers in the Selection List. 

 
10.  As a result of this search, the Results tab has now appeared along side of the 

Map and Search tabs at the top of the application page.  Click on the Results tab.  
The information displayed on the Results tab page is additional attribute data 
coming from the County GIS layer.  Uncheck one or more of the Map It 
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checkboxes that correspond to some of the counties, and then click on the Map It 
button that appears at the bottom of the results records.  The map refreshes and 
now only those counties whose Map It checkboxes remained checked are 
selected (highlighted) and appear in the Selections List.  The Results tab can be 
used to further refine a selection.   
 
Note: The Results tab only appears after a search (from the Search tab) has been 
executed.  A selection done with the Advanced Tools Selection Tool does not 
activate the Results tab. 

 
11. Delete the Counties Selection List by clicking on the Delete Selection List  

button in the Selection List window. 
 

12. Click on the Search tab, and then click on the Municipality tab to run a 
municipality search.  Select a County (Mercer) then a Municipality (Hamilton) 
from dropdown boxes and click on Search button.  The application will zoom to 
the selected municipality, and a selection list will be created, with a record for that 
municipality.  If after zooming, the map scale is larger than 1:30,000, the Aerial 
Photos 2002 image will be rendered in the map view.  Click on the blue “1” 
hyperlink in the selection list to get more information on the selected 
municipality.  Close the More Information window. 

 
13. Click inside the map Scale box, enter 15000, and then click on .  This will zoom 

the map view to a scale of 1:15,000. 
 

14. In Layer Manager, expand the Land group by clicking on , and check on Land 
Use Change 1995-2002.   Click the Apply button at the top of the Layer 
Manager window.  The areas where the land use changed between 1995 and 
2002 will be displayed in yellow.  In Layer Manager, right click on the Land Use 
Change 1995-2002 layer name and click on Make Layer Active.  The name 
should now have a light blue background.  Click on  for Land group to contract 
the group’s list. 

 
15. Use the Pan  tool to center the map view on one of the polygons where the land 

use changed (yellow polygon). 
 

16. Click on the Identify  tool from the Map Tools toolbar and click on a Land Use 
Change 1995-2002 polygon.  The More Information window will open, and 
display attribute information for that land use polygon.  Compare the values for the 
Land Use attribute for 2002 and 1995 for several changed land use polygons.  Of 
particular interest are land use categories that are being lost to development.  
Typically this would include the transformation of forest, agriculture, and wetlands 
to urban (commercial or residential) use. 

 
17. Close out of NJ-GeoWeb. 
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NJ-GeoWeb Tutorial 3:  Setting the Scale, Using Layer Manager Right-Click, & 
Advanced Tools  
 

1. Launch NJ-GeoWeb 
 
2. Click on Advanced Tools to open the Advanced Tools toolset.  Click on Locate 

Point Using NJ State Plane Coordinate.  In the dialog box, enter the value 
607300 for Easting (x), 681600 for Northing (y), and 25,000 for scale.  Click on the 
Search button.  After the map zooms to the coordinates, close the Locate Point 
Using NJ State Plane Coordinates dialog box. 

 
3. In Layer Manager, expand the Sites and Facilities layer group (click on ), and 

check on Chromate Sites.  Click on the Apply button at the top of the Layer 
Manager window.  The Chromate Site will display (green stars). 

 
4. Right click on the Chromate Sites’ layer name in Layer Manager and a grey sub-

menu will appear.  Click on Zoom to Full Layer Extent.  The map viewer zooms 
to the full spatial extent of the layer.  What happened to the Chromate Sites layer 
on the map?   

 
If it disappeared, the Chromate Sites’ layer name in Layer Manager has changed 
to grey.  Move your mouse cursor so it is directly on Chromate Sites’ layer name 
in Layer Manager and hold it there for a few seconds.  A popup message will 
appear that indicates between what scales this layer displays –“Chromate sites 
Visible Scale Range Min: 0 Max 200000”.  Check the displayed map scale (look 
for the ‘Scale’ tool at the bottom left of the map viewer).  If it indicates a scale 
above the Max number (200000) for Chromate Sites, the layer will not appear on 
the map.  If it is still visible, enter a map scale larger than 200000 so that it does 
disappear. 

 
5. Right click again on the Chromate Sites’ layer name in Layer Manager and click 

on Zoom to Visible Scale from sub-menu.  This time the map viewer zooms to a 
scale value below the Max (200000) and the Chromate Sites are visible again.  
The Chromate Sites’ layer name in Layer Manager has changed from grey back 
to black.  Note you may no longer be viewing the full spatial extent of the layer. 

 
6. Right click again on the Chromate Sites’ layer name in Layer Manager and click 

on View Metadata from sub-menu.  This will launch the NJ-GeoWeb Data 
Descriptions window that provides a brief layer description.  Click on the full 
metadata button at the end of the layer’s description to launch a window that 
displays the layer’s full metadata.  The metadata document provides a wealth of 
information associated with the layer.  After viewing the metadata document, 
close both the metadata and NJ-GeoWeb Data Description windows. 

 
7. Right click again on the Chromate Sites’ layer name in Layer Manager.  Click on 

Make Layer Active from sub-menu.  This will make Chromate Sites the active 
layer, and the layer’s name will have a pale blue background.  Only one layer can 
be the active layer at a time.  The active layer setting is important when the user 
wants to use some of the tools, primarily the Identify tool. 
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8. Click on the Identify  tool from the Map Tools toolbar and click on one of the 

Chromate Sites. A More Information window will appear with layer attributes for 
that site.  Close the More Information window. 

 
9. Click on the Selection  tool in the Advanced Tools toolset.  This will open the 

Selections window.  Using the Selection Layer dropdown menu select Chromate 
Sites.  For the selection method, use Select by Polygon .  You are going to 
define a polygon using mouse-clicks to input a sequence of vertices. Find a tight 
cluster of Chromate Sites in a small area.  Any Chromate Sites that fall within the 
boundary of the polygon you define will be selected.  On the last vertex, double 
click the mouse rapidly to complete the polygon.  A Selection List window will 
appear that lists the set of selected Chromate Sites.  The reference numbers (blue 
underlined numbers) correspond to the labels displayed on the map. 

 
10. Close both the Selections and Advanced Tools windows, leaving open the 

selection list window. 
 

11. In Selection List window click on the Show More Selection Tools  button on 
the Chromate Sites toolbar.  This will open a secondary toolbar.  Click on the 
Zoom to Active Selections  from this toolbar.  This will zoom the map view to 
the extent of the selected Chromate Sites only.  From this same toolbar click on 
the Toggle Indexing  button.  This turns off the labels for the selected points.  
Click on Toggle Indexing  again to bring the labels back.  Close the Selection 
Tools toolbar. 

 
12. Click on Advanced Tools to open the Advanced Tools toolset, and click on the 

Measure  tool.  Click on the View Coordinate  tool, and find a location 
centrally located to the selected set of Chromate Sites.  Click on this location on 
the map.  The coordinate of the point is displayed in the Measure window. Next, 
click on the Add to map button in the Measure window.  The coordinate is added 
to the Selection List window and is labeled on the map.  Make the Chromate 
Sites selection set the active selection by clicking on the Set Selection List as 
Active  button on the Chromate Sites section of the Selection List window.  
This should bring the Chromate Sites section of the Selection List to the top of the 
Selection List window, and re-label the Chromate Sites on the map. 

 
13. Use the mouse to highlight and copy to the clipboard the coordinate information 

(i.e., X: 610891.070820717 , Y: 683407.546282296 ) shown in the Selection List 
window.  This can be pasted into a map document created in the next step. 

 
14. In the browser tool bar, select File > Print … to print the map. (See Chapter 5 for 

detailed help on printing the map.) 
 

15. In the Measure window, click on the Measure Distance  tool. The Measure 
Distance tool requires the entry of two mouse clicks on the map - a beginning and 
ending point.  First, click on the marker symbol (circle) on the map that represents 
the located coordinate. Next, click on any one of the Chromate Sites. The linear 
distance between the located coordinate and the Chromate site will be displayed 
in the Measure window. The user may change the distance units (feet or miles) 
by using the Distance Unit dropdown in the Measure window.  Click on the Add 
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to map button.  This will add a graphical representation of the measurement and 
will add the measurement to the Selection List. 

 
16. Repeat the last step several times – measuring from the located coordinate to 

several other Chromate Sites using the Add to map button each time.  After the 
distances to several have been measured, close the Measure window and close 
the Advanced Tools window. 

 
17. In the browser tool bar, select File > Print … to print the map.  (See Chapter 5 for 

detailed help on printing the map.) 
 
18. Close out of NJ-GeoWeb. 



 

NJ-GeoWeb Tutorial 4:  Buffer NJEMS Sites and Using DEP Data Miner 
 

1. Launch NJ-GeoWeb  
 

2. Click on the Search tab and display all of the available searches by clicking on 
the All Searches tab. 

 
3. Select the NJEMS Sites in an Area of Interest search by clicking on its link. 

 
4. On the NJEMS Sites search window, a user can use the dropdowns to build a 

search that will retrieve NJEMS sites within an area of interest and optionally by 
NJDEP program.  The user must designate an area of interest by selecting a 
county, or combination of county/municipality, or a combination of watershed 
management area/watershed/sub-watershed using the provided dropdown 
menus.  Select Camden for county and Bellmawr Boro for municipality. Under 
Options, select Site Remediation for Program and Y (Yes) for the sites Active 
Flag.  Click on the Search button to execute the search. 

 
5. The map viewer will zoom to the selected NJEMS in Bellmawr Boro and the 

selected sites will appear in the Selection List window.  Note that all of the sites 
satisfying the search criteria will highlight, but only 20 will be labeled on the map.  
The 20 labeled on the map correspond to the 20 listed currently in the Selection 
List window.  At the bottom of the Selection List window for the selected NJEMS 
sites are page links that allow you to list sites after the first 20.  Click on the 
second page link (2).  Notice that the selection list now lists records 21-40, and 
that these labels now appear on the map.  Go back to the first page by clicking 
page link 1. 

 
6. Click on Advanced Tools to open the Advanced Tools toolset.  Click on Buffer 

Selections .  We will buffer the active selections (NJEMS Sites in Bellmawr 
Boro, with Site Remediation program interests that are active) by 1000 feet, and 
determine if any Public Community Water Supply Wells are within the buffered 
areas.  Select Public Community Water Supply Wells for the Target Layer, and 
1000 feet for the buffering distance.  Click on the Show buffer shape only 
checkbox and then click on Select.  With the Show buffer shape only checkbox 
checked, only the buffers display – no features from the target layer (Public 
Community Water Supply Wells) are highlighted and selected.  Uncheck the 
Show buffer shape only checkbox and click Select again, the Public Community 
Water Supply Wells that are within the buffered areas are selected (added to the 
Selections List) and highlighted (labeled).  Close the Buffer Selections window. 

 
7. The buffered selection set, the Public Community Water Supply Wells within 1000 

feet of the selected NJEMS sites, relates to the current active selection list.  The 
current active selection list always appears at the top of the Selection List 
window.  For each well in the Selection List window, click on the well’s index 
number hyperlink (blue).  This will open a More Information window that displays 
the attribute data for each well.   
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8. Next, look for the NJEMS Sites section of the Selection List.  Make the NJEMS 
Sites the current active selection list by clicking on the Set Selection List as 
Active tool  on the NJEMS Sites portion of the Selection List tool bar.  This 
should move the NJEMS Sites portion of the Selection List to the top of the 
Selections List window.  The NJEMS Sites should now be labeled on the map and 
the wells should now be highlighted with a yellow circle symbol. 

 
9. Advance through the NJEMS Sites Selection List by using the page links at the 

bottom of the NJEMS Sites list, until you determine which of the NJEMS Sites are 
closest to the wells. 

 
10.  Find the NJEMS Site named “EVERGREEN PRINTING & PUBLISHING CO 

INC”.  This site is near 2 of the wells.  Click on this site’s index number (blue 
hyperlink) in the Selection List.  This opens the More Information window which 
displays the attributes for the site.  Click on the Documents link at the bottom of 
the window to expose the link to Data Miner reports (Data Miner - Program 
Interest by Site ID).  Click on the Data Miner report link to launch Data Miner. 

 
11. In the Data Miner application, click on the Reports dropdown menu which is all 

the way to the right-hand side of the application window.  Select the Permits by 
Timeframe report, and then click on the  button to call the report.  When the 
report page appears, accept the default settings and click on the OK button.  After 
a few moments the report executes, and information about the site appears. 

 
12. Close the Data Miner Application. 

 
13. Close out of NJ-GeoWeb. 

 23



 24

7.  Summary 
 

This short overview of NJ-GeoWeb should have provided a sampling of what can be 
done using the application.  The short tutorials were designed to show most of the 
features and tools currently available.  NJ-GeoWeb is meant to enable those who are 
not GIS experts to use GIS tools to conduct environmental analysis.  Though the 
application has added functionality to that found in the earlier i-MapNJ, it is not 
intended to contain all the features found in desktop GIS software.  However, it 
should provide the tools to accomplish the tasks that are most commonly requested 
by NJDEP staff and members of the public interested in NJDEP data.   
 
NJ-GeoWeb also begins to provide the linkage between the Department’s spatial 
data and its permit and facility related information.  This is done through use of the 
online application DEP Data Miner.  This connecting of GIS data and tools with 
NJDEP programmatic data represents the beginning of what should prove to be very 
powerful for environmental analysis that can be done by the concerned citizen, from 
home via the Internet. Until just recently, this was something only the trained 
professional could accomplish, and only through the use of specialized and costly 
software.  These types of tools (and associated access to information) are 
increasingly expected by the public, consultants, and various types of stakeholders, 
who have become familiar and comfortable with mapping applications such as 
Google Earth and Microsoft Live Local.    
 
Finally, it is important to note that NJ-GeoWeb is really a work in progress.  Current 
software for customization of interactive mapping applications provide many tools and 
options that can be provided. As work continues on the application new tools will be 
added in response to the needs of users and the capabilities of the software. The 
ability to print a map, for example, is a needed function that must wait for a software 
update. Of course, it is not possible or appropriate to provide all of the tools currently 
available.  BGIS strives to accommodate the needs of most users of NJ-GeoWeb, 
within the constraints posed by funding availability, data structures, technology and 
demands on staff time. The core functionality of NJ-GeoWeb will be enhanced 
incrementally as the situation permits, and in response to user requests. 
 
The NJ-GeoWeb development team hopes that you enjoy using this application, and 
welcomes your comments or suggestions.  Please direct your comments and 
inquiries to the Bureau of GIS.  

 Contact Information for Questions or Comments: 
 

 New Jersey Department of Environmental Protection 
 Office of Information Resources Management 
 Bureau of Geographic Information Systems 

PO Box 428 
 Trenton, NJ 08625-0428 
 

Main Number (609) 292-3211  
GIS Help Desk (609) 777-0672 
email:  gisnet@dep.state.nj.us  

 web page:  http://www.nj.gov/dep/gis 
 

mailto:gisnet@dep.state.nj.us
http://www.nj.gov/dep/gis
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8. Frequently Asked Questions 
 

FREQUENTLY ASKED 
QUESTIONS ANSWERS 

What versions of web browsers 
work with NJ-GeoWeb?  

NJ-GeoWeb performs reliably in Microsoft's Internet 
Explorer (version 6.0 or higher) and Mozilla's Firefox. It 
may run to some degree, though less reliably, in other 
web browsers. NJ-GeoWeb utilizes POPUP windows 
for display of query results. You may need to disable 
popup blocking software you have running on your 
computer to ensure proper functionality of this 
application.  

This application works best with screen resolution of 
1024x768 or 1152x864. (Right click on your 
computer's desktop, select Properties, and then select 
Settings from the pop-up menu.)  

Why does the NJ-GeoWeb 
application's performance vary 
throughout the day?  

The NJ-GeoWeb application is a web application 
whose performance is subject to a number of factors 
including the user's connection to the Internet 
(broadband vs. dial-up), the amount of data that is 
being requested from the application's servers, and 
how many concurrent requests to those servers are 
being made by all of the users at any given time.  

Why won’t the mapped 
information come into the field 
of view when I launch NJ-
GeoWeb?  

Cancel out and try again, or wait for 20 minutes or so 
and try again. If the application will still not load, email 
the NJDEP at Contact Us on the Splash Page.  

Why can't I find the address I 
am interested in when I use the 
Address Search? 

Achieving success when searching for an address is 
dependent on a few factors. Often what prevents a 
match is a situation where a street or road is known by 
more than one name (US Highway 1, Route 1, 
Brunswick Pike, etc.). If your address is in a more 
recently developed area, the roads layer that contains 
the address range information may not be current 
enough, preventing a successful match. There can 
also be address range coding errors in the roads layer. 
If searching for a specific address does not work, try 
another (if known) close to the original address. With 
the aid of the orthophotography (aerial photo image) 
users can often find their location of interest after 
recognizing familiar features such as major roads, 
streams, waterbodies, building structures, parks, etc. 



Why am I having trouble 
getting the aerial photos to 
become visible in the map view 
frame?  

The aerial photos are scale dependent and are only 
available after the user has zoomed into a municipality 
or small study area. They also have a minimum scale 
so they won't be available if you zoom in too far. The 
2002 and 1995/97 aerial photos should appear at 
scale values between 30,000 and 1,000. The 1930s 
aerial photos should appear between 30,000 and 
5,000. You can reference the map's current scale 
value at the bottom of the map frame in the map scale 
box. You can type in any value within the aerial photo's 
visible range and click on the arrow button  to zoom 
to see the imagery.  

Why aren't all of the layers in 
the Layer Manager available at 
all scales?  

From a performance perspective, it doesn't make 
sense to have every layer available at all scales. A 
layer like Land Use 2002 is a very detailed layer 
defined by many data points, and this detail goes 
unnoticed when viewing at a small scale (statewide 
view). The fact that the layer is very detailed means 
that more effort and time is required by the 
application's server to draw a map that includes the 
layer. If a layer's name in the Layer Manager is 
displayed in black, then it is available for display at the 
current scale. If the layer's name is displayed in gray, 
then it is unavailable at the current scale. If you 
mouse-over a layer's name in Layer Manager, the 
application will indicate any scale settings for that 
layer. Most layers will be available for display if the 
user is zoomed to a municipality or small study area 
(large scale). NJDEP has classified most layers in NJ-
GeoWeb to be available at specific scales (scale 
dependent), so as users zoom in to larger and larger 
scales, generally more layers become available for 
display.  

Why can’t I see the Category 
One Streams statewide? 

NJDEP has classified each layer in NJ-GeoWeb to be 
available at specific scales. Because of its level of 
detail, the Category One Waters layer becomes 
available only after the user has zoomed in to a scale 
between 1:100,000 and 1:1,000. 

How can I buffer a Category 
One Stream by 300 feet to 
determine if it is regulated? 

Use the Selection tool (in Advanced Tools) to select 
the stream segments you would like to buffer. Usually 
selecting by rectangle or polygon works best. Once the 
stream segments are selected, you can then use the 
Buffer Selection tool to enter the buffer distance of 
300 feet and a target layer from which features will be 
selected that fall within the buffer.  
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Why did my map retrieval fail? When executing a search, or zoom, or pan, you must 
allow the process (spiraling indicator) to complete or 
you will disrupt the data flow (request/response cycle) 
that the application must complete before additional 
user interaction. For this reason, it is recommended 
that users not click on the map or initiate other viewer 
actions while data transfer is in progress.  

If you are experiencing problems, it is usually best to 
quit out of NJ-GeoWeb and relaunch the application. 

Where do I get information on 
the mapped data used in NJ-
GeoWeb? 

This information is available by clicking on the data 
descriptions button above the Map Tools toolbar. This 
opens a window that lists all map layers. A brief 
description of the data is provided when a user clicks 
on the name of a layer. If a user wants to see further 
information, they may click on the full metadata button 
to view FGDC compliant metadata. The user can also 
get to this information by right-clicking on a layer name 
in Layer Manager and selecting Metadata from the 
menu. 

What coordinate system is the 
information mapped in?  

The mapped data in the application is in the New 
Jersey State Plane Coordinate System (NJSPCS), in 
units of US Survey Feet, referenced to the North 
American Datum of 1983 (NAD 83) horizontal geodetic 
datum. 

How can I find the New Jersey 
State Plane Coordinates for a 
point of interest using NJ-
GeoWeb? 

First, navigate to your area of interest. This can be 
done using either an existing search (Municipality, 
Place, sub-watershed, etc.) or if you are more familiar 
with the location in relation to the entire state, you can 
use the Zoom In  tool. Once zoomed to a scale 
greater than 1:30,000, the aerial photos become 
visible, and you can turn on additional layers (major 
roads, roads, streams, etc.) to help orient yourself on 
the map. Look for physical features (building 
structures, open spaces, athletic fields, water bodies, 
etc.) in or near your area of interest. Once you have 
found the location for which you want coordinates, use 
the Measure tool (in Advanced Tools), and use the 
View Coordinates (pushpin ) tool. Move your cursor 
over the point of interest on the map and click. You will 
see the coordinates in the Measure tool dialog. The 
first coordinate is the Easting or “X” value and the 
second number is the Northing or “Y” value. In 
reporting these coordinate values to the NJDEP, they 
may be rounded to the nearest foot (integer).  
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If you are a new user or trying to find coordinates 
for an NJDEP regulated facility, please call the GIS 
Help Desk at: (609) 777-0672 

Can I export or print the tabular 
data from the Selection List or 
More Information windows? 

Yes, the Report/Export Editor button at the top of the 
Selection List provides several basic output options 
(.csv, .html, and .pdf) for outputting selected features' 
attribute data. In addition, near the top of the More 
Information window, there is a Reports dropdown 
menu that provides the same choices for exporting the 
attributes currently in the More Information window.  

Can I export the tabular data 
from the current Selection Set 
in the Selection List window to 
a spreadsheet?  

By using the Report/Export Editor button at the top of 
the layer's Selection List you can export the attribute 
data in the Selection List to the Basic Report (CSV) 
option from the dropdown.  

Can I add a GIS data layer that I 
have stored locally on my 
computer to the NJ-GeoWeb 
application?  

Not currently. NJDEP is planning on providing such 
capabilities in a future release.  

Can I change the symbology of 
the layers or the order in which 
they overlay?  

Unlike GIS desktop applications like ArcView and 
ArcExplorer, you can not alter the colors and symbols 
of the layers in NJ-GeoWeb. Layer drawing order can 
be changed by clicking on a layer's name in Layer 
Manager and dragging it with the mouse button still 
pressed to a different order location. This change is in 
affect for the current session only. 

Can I select an area of interest 
by parcel number (block and 
lot)?  

At this point in time, the State is working on an 
initiative to standardize parcel data layers developed 
by the state's counties. This will eventually lead to the 
development of a search in NJ-GeoWeb for a parcel 
based on block and lot.  
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